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はじめに
このマニュアルでは、シングル・サーバを導入する方法、このサーバをマルチプ
レックスに変換する方法、クエリを実行してマルチプレックス内のすべてのノー
ドで分散処理する方法について説明します。
このマニュアルでは、実行するタスクを順を追って説明しています。1 つの手順
内のタスクを完了してから次の手順に進むようにしてください。 すべてのタスク
完了までの所要時間は、約 20 分です。

1. シングル・サーバの作成
最初のタスクでは、シングル・サーバ環境にデモ・データベースを導入しま
す。

2. サーバのマルチプレックスへの変換
デモ・データベースをマルチプレックスに変換します。

3. ワークロードの分散
マルチプレックス環境では、クエリ・オプティマイザが複雑なクエリを複数の
フラグメントに分割します。フラグメントは、さまざまなノードで分散処理さ
れます。

シングル・サーバの作成
最初のタスクでは、シングル・サーバ環境にデモ・データベースを導入します。
1. 環境変数の設定

Sybase IQ 環境変数は、さまざまなディレクトリおよびファイルの場所を指し
ます。通常は、インストーラによって多くの変数が自動的に設定されますが、
新しい端末またはコンソールを使用する場合は、手動でこれらの変数を設定し
てください。

2. デモ・データベースの作成
Sybase IQ には、スポーツ衣料を販売する架空企業に関するサンプル・データ
を格納するデモ・データベースが含まれています。 Sybase IQ Server Suite の一
部として、このデモ・データベースを作成およびロードするスクリプトがイン
ストールされます。

3. サンプル・クエリの実行
Interactive SQL は、Sybase IQ に同梱されているユーティリティです。Interactive
SQL を使用してサーバに接続し、サンプル・クエリを実行します。

はじめに
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参照：
• サーバのマルチプレックスへの変換 (4 ページ)

環境変数の設定
Sybase IQ 環境変数は、さまざまなディレクトリおよびファイルの場所を指しま
す。通常は、インストーラによって多くの変数が自動的に設定されますが、新し
い端末またはコンソールを使用する場合は、手動でこれらの変数を設定してくだ
さい。
1. コンソールまたは端末を開きます。
2. $SYBASE 変数を、親インストール・ディレクトリに設定します。
シェル コマンド
tcsh または C (csh) setenv SYBASE <directory name>

Korn (ksh)、Bash、または Bourne (sh) SYBASE=<directory name>; 
export SYBASE

3. $IQDIR15 変数を、Sybase IQ 製品ディレクトリに設定します。
シェル コマンド
tcsh または C (csh) source $SYBASE/IQ-15_4/IQ-15_4.csh

Korn (ksh)、Bash、または Bourne (sh) $SYBASE/IQ-15_4/IQ-15_4.sh

注意： 環境変数の詳細については、『リファレンス：ビルディング・ブロッ
ク、テーブル、およびプロシージャ』の「ファイル・ロケーションとインス
トール設定」>「環境変数」を参照してください。

デモ・データベースの作成
Sybase IQ には、スポーツ衣料を販売する架空企業に関するサンプル・データを格
納するデモ・データベースが含まれています。 Sybase IQ Server Suite の一部とし
て、このデモ・データベースを作成およびロードするスクリプトがインストール
されます。
この手順は、『インストールおよび設定ガイド』で説明されている手順とは異な
ります。このタスクでは、myiqdemo という名前のテンポラリ・ディレクトリの
絶対パスを使用してデモ・データベースを作成します。
1. $SYBASE ディレクトリに移動します。
2. myiqdemo という名前のサブディレクトリを作成します。
これは、デモ・データベースを格納するテンポラリ・ディレクトリです。この
ディレクトリのフル・パスは、次のようになります。
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$SYBASE/myiqdemo

3. myiqdemo に移動します。
4. w1 という名前のサブディレクトリを作成します。
このディレクトリは、後でマルチプレックスへの変換で使用します。このディ
レクトリのフル・パスは、次のようになります。
$SYBASE/myiqdemo/w1

5. 次のように入力します。
$IQDIR15/demo/mkiqdemo.sh -absolute

-absolute スイッチは、絶対パスを使用してデモ・データベースを作成します。
デモ・データベースをマルチプレックスに変換する場合は、絶対パスを使用す
る必要があります。他のオプションについては、次のように入力します。
$IQDIR15/demo/mkiqdemo.sh -help

6. デモ・データベースを起動します。
start_iq @iqdemo.cfg iqdemo.db

サンプル・クエリの実行
Interactive SQL は、Sybase IQ に同梱されているユーティリティです。Interactive
SQL を使用してサーバに接続し、サンプル・クエリを実行します。

1. 次のように入力します。
dbisql

Interactive SQL が起動し、接続ダイアログが開きます。
2. 次の接続パラメータを使用します。
タブ名 フィールド 値
[IQ データベース
に接続]

[認証] [データベース]

[ユーザ ID] DBA または dba (大文字と小文字の区別なし)

[パスワード] sql (大文字と小文字の区別あり)

[アクション] [このコンピュータで稼動しているデータベースに
接続]

3. [SQL Statements] ウィンドウで、次のように入力します。
SELECT
SalesOrders.ID,
SalesOrders.OrderDate,
Customers.CompanyName

FROM SalesOrders 
KEY JOIN Customers

はじめに
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WHERE OrderDate > '1994/01/01'
ORDER BY OrderDate

他のクエリ・オプションも使用できます。テーブルと所有者のリストについて
は、『インストールおよび設定ガイド』の「インストールされた製品のテス
ト」>「デモ・データベース」>「テーブル名」を参照してください。

4. [F9] を押し、クエリを実行します。
5. [File] > [Exit] をクリックし、Interactive SQL を終了します。

サーバのマルチプレックスへの変換
デモ・データベースをマルチプレックスに変換します。
コマンド・ラインでも同等のタスクを実行できますが、この手順のすべてのサー
バ関連タスクでは、Sybase 製品の管理コンソールである Sybase Central を使用しま
す。Sybase Central では、グラフィカル環境でサーバを管理できます。
Sybase Central を使用してデモ・データベースをマルチプレックスに変換すると、
処理環境に発生する変更を確認できます。
1. Sybase IQ Agent の起動

Sybase IQ Agent は、Sybase IQ と Sybase Central の間の通信チャネルを提供しま
す。Sybase Central は、アクティブな Sybase IQ Agent を使用してサーバ関連タス
クを実行します。

2. Sybase Central の起動
Sybase Central を起動し、サーバに接続します。

3. マルチプレックス・サーバの定義
Create Server ウィザードを使用して、シングル・サーバをマルチプレックスに
変換します。

4. マルチプレックスへのデータのロード
コーディネータおよびライタを使用して、マルチプレックスにデータをロード
し、マルチプレックス・リソースを最大限に活用します。

参照：
• シングル・サーバの作成 (1 ページ)

• ワークロードの分散 (11 ページ)
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Sybase IQ Agent の起動
Sybase IQ Agent は、Sybase IQ と Sybase Central の間の通信チャネルを提供します。
Sybase Central は、アクティブな Sybase IQ Agent を使用してサーバ関連タスクを実
行します。
1. コンソールで、$IQDIR15/bin64 に移動し、次を入力します。

S99SybaseIQAgent15

このコマンドを実行すると、Sybase IQ Agent が起動し、ポートが 1099 に設定さ
れます。

2. エージェントが稼働していることを確認します。
stop_iq -agent

注意： Sybase IQ は、エージェント・ログ・ファイルを $IQDIR15/logfiles/

SybaseIQAgentNNNN.MMM.log に書き込みます (NNNN はポート番号、MMM は連
続番号です)。 環境変数 $IQLOGDIR15 が設定されている場合、エージェント・ロ
グ・ファイルは $IQLOGDIR15 ディレクトリにあります。

Sybase Central の起動
Sybase Central を起動し、サーバに接続します。

1. 次に移動します。
$IQDIR15/bin64

2. 次のように入力します。
scjview

3. 必要に応じて、[Tips] および [Welcome] ウィンドウを閉じます。
4. [View] - [Folders] を選択します。
5. [Connections] - [Connect with Sybase IQ] を選択します。
6. [Connect] ダイアログで、次を入力します。
タブ名 フィールド 値
[IQ データベース
に接続]

[認証] [データベース]

[ユーザ ID] DBA または dba (大文字と小文字の区別なし)

[パスワード] sql (大文字と小文字の区別あり)

[アクション] [このコンピュータで稼動しているデータベースに
接続]

はじめに
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マルチプレックス・サーバの定義
Create Server ウィザードを使用して、シングル・サーバをマルチプレックスに変換
します。
このマニュアルでは、プレースホルダ <localhost> を使用してホストを指定します。
手順でこのプレースホルダが使用されているときは、代わりに該当するホスト名
を使用してください。
1. [Folders] で、[<localhost>_iqdemo] サーバ・アイコンを右クリックし、[Agent] >

[Properties] を選択します。
2. 必要に応じて、[Agent Properties] を更新します。
フィールド名 値
[Username] DBA または dba (大文字と小文字の区別なし)

[Password] sql (大文字と小文字の区別あり)

[Port] 1099 (デフォルト)

[Timeout] 5 (分、デフォルト)

3. [OK] をクリックして、Sybase Central に戻ります。
4. [Folders] で、[<localhost>_iqdemo] サーバを右クリックし、[Convert to Multiplex]
を選択します。
Multiplex Server Conversion ウィザードは、複数の要素で構成されています。

タイトル 説明
Node Configuration 新しいマルチプレックス・ノードの設定
Database Path 新しいマルチプレックス・セカンダリ・サーバのデータ

ベース・ファイルへの絶対パス
Temporary Dbspace Config-
uration

テンポラリ DB 領域ファイルのサイズとパス

Review of Settings マルチプレックス設定の概要
5. 画面に表示される手順に従います。

参照：
• マルチプレックスへのデータのロード (10 ページ)

はじめに
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サンプルの変換値
Server Creation ウィザードは、変換しているシングル・サーバから一部のデフォル
ト・フィールド値を抽出します。この手順に関連するサンプル変換値を参照して
ください。

ノード設定
[Node Configuration] ダイアログでは、マルチプレックス・ノード設定のプロパ
ティを設定します。
フィールド
名

説明

Multiplex
Server Name

このウィザードは、変換しているシングル・サーバの名前から、この
フィールドのデフォルト値を抽出します。<localhost>_iqdemo

次に変更します。<localhost>_iqdemo_mpx

Server Name マルチプレックス内の 1 つ目のセカンダリ・サーバの名前です。この値
は、マルチプレックスのコーディネータ・サーバになる、変換中のサーバ
とは異なる必要があります。
次の値を使用します。<localhost>_iqdemo_w1

Host
Information

この手順では、ウィザードに表示されるデフォルトのホスト名とポート番
号を使用します。これらの値を使用すると、同一ホスト上の複数のサーバ
でマルチプレックスを設定できます。

Agent この手順では、次の値を使用してマルチプレックスを Sybase IQ Agent にバ
インドします。
[Port] 1099 (デフォルト)

[Username] DBA (大文字と小文字の区別な
し)

[Password] sql (大文字と小文字の区別あ
り)

Mode [Reader] から [Writer] に変更します。後でデータをロードするときに、こ
のノードを使用します。

Create admin-
istrative shell
scripts.

サーバの起動、停止、同期用のスクリプトを生成します。

はじめに
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データベース・パス
[Database Path] ダイアログでは、データベース・ストアへの絶対パスを設定しま
す。
フィールド 説明
Database Path この手順では、パスを $SYBASE/myiqdemo/w1 サブディレクトリ

に設定し、セカンダリ・サーバ・データベース・ファイルを
iqdemo_w1.db として指定します。

パスは参照できますが、データベース・ファイル名 (iqdemo_w1.db)

を入力する必要があります。
フル・フィールド値は、次のようになります。
$SYBASE/myiqdemo/w1/iqdemo_w1.db

Coordinator’s
configuration
options

[Use Coordinator’s configuration options] を選択し、既存のデータベースの
params.cfg オプションを新しいマルチプレックス・サーバのデータ
ベース・ディレクトリにコピーします。

テンポラリ DB 領域設定
[Temporary Dbspace Configuration] ダイアログでは、テンポラリ DB 領域ファイルへ
のパスを設定します。
フィールド 説明
Temporary
dbspace file
path

この手順では、パスを $SYBASE/myiqdemo/w1/iqdemo_w1.

iqtmp に設定します。

パスは参照できますが、データベース・ファイル名
(iqdemo_w1.iqtmp) を入力する必要があります。

RAW device
option

[This is a raw device] オプションの選択を解除して、デフォルトのファイ
ル・サイズ値と予約サイズ値を表示します。この手順では、これらの値
を変更しません。

設定の確認
変換値を確認します。

はじめに
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マルチプレックス・ビュー
シングル・サーバをマルチプレックスに変換すると、Sybase Central にさまざまな
ビューが追加されます。

フォルダ ビュー
新しいマルチプレックスは、マルチプレックス・フォルダの一部になります。新
しいマルチプレックス・フォルダを展開すると、マルチプレックス内のオブジェ
クトが表示されます。
ビュー 説明
Multiplex
Server

新しいマルチプレックスは、次の名前になります。
<localhost>_iqdemo_mpx

Coordinator コーディネータは、マルチプレックス・リソースを管理します。コー
ディネータは、次の名前になります。
<localhost>_iqdemo

Writer ライタは、読み取り専用および読み取り／書き込み操作を共有 IQ オブ
ジェクトに対して実行できます。ライタは、次の名前になります。
<localhost>_iqdemo_w1

マルチプレックスのプロパティ
マルチプレックスのプロパティは、右ウィンドウ枠に表示されます。フォルダ
ビューで、マルチプレックス・サーバまたはそのメンバーの 1 つを選択すると、
そのプロパティが表示されます。
ビュー 説明
Servers [Servers] タブには、マルチプレックス内のサーバが表示されます。

• <localhost>_iqdemo (コーディネータ)

• <localhost>_iqdemo_w1 (ライタ)

Topology [Topology] タブには、マルチプレックスのグラフィカルなビューが表示され
ます。
マルチプレックス・トポロジで任意のオブジェクトを右クリックすると、
そのオブジェクトのコマンド・オプションが表示されます。

はじめに
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ビュー 説明
Perform-
ance Moni-
tor

[Performance Monitor] タブでは、マルチプレックスおよびサーバ・レベルで
パフォーマンスの統計情報をモニタできます。
マルチプレックス・レベルでは、複数サーバについて、一度に 1 つの統計
をモニタできます。サーバ・レベルでは、同時に最大 10 の統計をモニタで
きます。

マルチプレックスへのデータのロード
コーディネータおよびライタを使用して、マルチプレックスにデータをロードし、
マルチプレックス・リソースを最大限に活用します。
デモ・データベースの作成に使用したデータと同じデータをロードするので、サ
ンプル LOAD スクリプトには、TRUNCATE 文があります。この文は、ターゲッ
ト・テーブルのすべてのローを削除してからデータをロードします。
1. [Folders] で、[<localhost>_iqdemo] > [Open Interactive SQL] を右クリックします。
コーディネータに接続された Interactive SQL が起動します。

2. Interactive SQL で、次を入力します。
TRUNCATE TABLE Contacts;

LOAD TABLE Contacts (ID, Surname,GivenName,
Title, Street, City, State, Country, PostalCode,
Phone, Fax, CustomerID)
USING FILE '../IQ-15_4/demo/adata/contact.dat'
ROW DELIMITED BY '|'
ESCAPES OFF;
COMMIT;

1 行にデータ・ファイルへのフル・パスを入力します。
3. [F9] を押し、コーディネータ上に Contacts テーブルをロードします。
4. Interactive SQL を閉じます。
5. [Folders] で、[<localhost>_iqdemo_w1] > [Open Interactive SQL] を右クリックしま
す。
ライタに接続された Interactive SQL が起動します。

6. Interactive SQL で、次を入力します。
TRUNCATE TABLE SalesOrderItems;

LOAD TABLE SalesOrderItems (ID, LineID,
ProductID, Quantity, ShipDate)
USING FILE '../../IQ-15_4/demo/adata/sales_oi.dat'
ROW DELIMITED BY '|'
ESCAPES OFF;
COMMIT;

はじめに
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1 行にデータ・ファイルへのフル・パスを入力します。
7. [F9] を押し、ライタ上に SalesOrderItems テーブルをロードします。
8. Interactive SQL を閉じます。

参照：
• マルチプレックス・サーバの定義 (6 ページ)

ワークロードの分散
マルチプレックス環境では、クエリ・オプティマイザが複雑なクエリを複数のフ
ラグメントに分割します。フラグメントは、さまざまなノードで分散処理されま
す。
クエリを分散するときは、1 つのリーダ・ノードと 1 つ以上のワーカ・ノードを使
用します。クエリは、リーダ・ノードから発生します。ワーカ・ノードは、クエ
リ処理作業の一部を受け入れることができる、マルチプレックス内の任意のノー
ドとすることができます。マルチプレックスのすべてのタイプのノード (リーダ、
ライタ、またはコーディネータ) を、リーダまたはワーカ・ノードとすることがで
きます。
クエリを分散するかどうかは、クエリ・オプティマイザによって決定されます。
クエリを分散する場合は、リーダ・ノードがクエリを並列のフラグメントに分割
し、そのフラグメントをワーカ・ノードに割り当てます。ワーカは、フラグメン
トを処理して中間結果を返します。 サイズを適切に調整できない、またはパ
フォーマンスを低下させる可能性があるクエリは、分散されずにマルチプレック
ス内の単一のノード上で実行されます。
ここでは、大量のデータに対応できるようにマルチプレックスを変更し、分散ク
エリを実行する方法について説明します。
1. 共有テンポラリ・ストレージの追加
分散クエリ処理 (DQP：Distributed Query Processing) を実行するには、すべての
マルチプレックス・ノード間で共有できるテンポラリ・ストレージが必要で
す。このタスクでは、コーディネータおよびライタにテンポラリ・ストレージ
を提供するリソースをコーディネータ上に作成します。

2. iq_main ファイル・サイズの拡張
分散クエリを実行する前に、ユーザ DB 領域 iq_main でファイル・サイズを増
やします。

3. 分散クエリの実行
通常クエリ・エンジンは、少ないリソースしか必要としないクエリではなく、
多数のローを処理するクエリを分散します。

はじめに
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4. クエリ・プランの確認
マルチプレックス・ノードのディレクトリでクエリ・プランを確認します。
リーダ・ノードのディレクトリには、包括的なクエリ・プランがあります。ま
た、分散された作業単位ごとに、その作業単位を受け取ったノードによって生
成された HTML ファイルがあります。

参照：
• サーバのマルチプレックスへの変換 (4 ページ)

共有テンポラリ・ストレージの追加
分散クエリ処理 (DQP：Distributed Query Processing) を実行するには、すべてのマ
ルチプレックス・ノード間で共有できるテンポラリ・ストレージが必要です。こ
のタスクでは、コーディネータおよびライタにテンポラリ・ストレージを提供す
るリソースをコーディネータ上に作成します。
1. [Folders] で、[<localhost>_iqdemo_mpx] > [iqdemo] > [Dbspaces] を展開します。
2. [Dbspaces] フォルダで、[IQ_SHARED_TEMP] を右クリックし、[New] > [File] を
選択します。

3. [Add File (s)] ダイアログで、[Add] をクリックします。
4. [File Detail (s)] ダイアログを更新します。

オプ
ション

値

Logical
File Name

論理ファイル名として shared_temp を使用します。

Physical
File Path

パスを $SYBASE/myiqdemo サブディレクトリに設定し、セカンダ
リ・サーバ・データベース・ファイルを shared_temp.iqtmp として
指定します。
[This is a raw device] の選択を解除するとパスを参照できますが、ファイル
名を手動で入力する必要があります。フル・フィールド値は、次のよう
になります。
$SYBASE/myiqdemo/shared_temp.iqtmp

Raw de-
vice op-
tion

[This is a raw device] の選択を解除して、デフォルトのファイル・サイズ値
と予約サイズ値を表示します。

File Sizes 次の値を使用して更新します。
[File Size] 300MB

[Reserve Size] 90MB

はじめに
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5. [OK] をクリックして [Add File (s)] ダイアログに戻り、[OK] > [Next] > [Finish] を
クリックします。

6. [Files] タブで、[shared_temp] を右クリックし、[Properties] を選択します。
7. [Mode] を [Read/Write] に変更します。
8. [Apply] > [OK] をクリックします。

iq_main ファイル・サイズの拡張
分散クエリを実行する前に、ユーザ DB 領域 iq_main でファイル・サイズを増やし
ます。
1. [Folders] で、[<localhost>_iqdemo_mpx] > [iqdemo] > [Dbspaces] を展開します。
2. [Dbspaces] フォルダで、[iq_main] をクリックします。
3. [Files] タブで、[iq_main] を右クリックし、[Properties] を選択します。
4. [Properties] シートで、[Modify File Size] を 200 に変更します。
5. [Apply] > [OK] をクリックします。

分散クエリの実行
通常クエリ・エンジンは、少ないリソースしか必要としないクエリではなく、多
数のローを処理するクエリを分散します。
このタスクでは、2 つのスクリプトを使用して、膨大な量のサンプル・データ
(1000 万ロー) をロードし、クエリを実行します。最初のスクリプトでは、Fact
テーブルおよび Dimension テーブルを作成してロードします。2 つ目のスクリプト
では、3 つのローをフェッチするクエリを実行し、コーディネータ・サーバ・
ディレクトリとライタ・サーバ・ディレクトリにクエリ・プランを生成します。
1. [Tools] > [Sybase IQ 15] > [Open Interactive SQL] を選択します。
2. [Connect] ダイアログで、次を入力します。
タブ名 フィールド 値
[IQ データベース
に接続]

[認証] [データベース]

[ユーザ ID] DBA または dba (大文字と小文字の区別なし)

[パスワード] sql (大文字と小文字の区別あり)

[アクション] [このコンピュータで稼動しているデータベースに
接続]

3. Interactive SQL で、[File] > [Open] をクリックします。
4. $IQDIR15/demo を参照し、dqpdata.sql を選択します。

はじめに
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5. [F9] を押し、Fact テーブルおよび Dimension テーブルを作成してロードします。
6. [File] > [Open] をクリックします。
7. $IQDIR15/demo を参照し、dqpquery.sql を選択します。
8. [F9] を押し、クエリを実行してクエリ・プランを生成するスクリプトを実行し
ます。

クエリ・プランの確認
マルチプレックス・ノードのディレクトリでクエリ・プランを確認します。リー
ダ・ノードのディレクトリには、包括的なクエリ・プランがあります。また、分
散された作業単位ごとに、その作業単位を受け取ったノードによって生成された
HTML ファイルがあります。
Web ブラウザでクエリ・プランを開くには、リーダ・ノードのディレクトリをダ
ブルクリックします。クエリ・プランは、クエリ・ツリーと呼ばれる構造で視覚
的に表示されます。

図 1 : Sybase IQ のサンプル・クエリ・プラン

クエリ・ツリー
クエリ・ツリーは、クエリのデータ・フローを表します。クエリ・ツリーはノー
ドで構成され、各ノードは作業の段階を表します。各ノードは、名前とデータ・
フロー演算子 (DFO) 番号を持ちます。ツリー内のすべてのノードは、詳細情報に
ハイパーリンクされています。

はじめに

14 Sybase IQ



ツリーの一番下のノードはリーフ・ノードです。各リーフ・ノードは、クエリ内
のテーブルまたはプリジョイン・インデックス・セットを表します。 プランの最
上部にあるのは、演算子ツリーのルートです。情報はテーブルから上方向に、
ジョイン、ソート、フィルタ、格納、集合、サブクエリを表す演算子を通じて流
れます。
クエリ演算を接続する 3 本の縦線は分散を示しています。たとえば、[Group By]
ノードと [Join] との間の 3 本の線は、この演算が並列スレッドで実行され、複数の
サーバに分散されることを示しています。 [Join] と [#01 Leaf] の間の演算も分散さ
れます。
注意： クエリ・プランの詳細については、『パフォーマンス＆チューニング・ガ
イド』を参照してください。

はじめに
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